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JLCT vy L— AT V=7 FEERLET,

WD 7 2 3 Novell NetWare Migration Wizard D 3{T] ([ZH#A TL 72
I,

Novell NetWare Migration Wizard M 4T

1 Novell Software Downloads Web - I (http://www.novell.com/download/)
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5 [NetWare 3] > [OK] DJEIZZ U v 27 LET,
6 [View Setup Tasks] ™"Z > %27 Vv 7 LET,

ZHUCXKY, TN ND Web 7T U HNEESE L, NetWare
Migration Wizard 6 DA > 7 A L~V TR E £7,

9 N—VDH 13 NetWare 3 O DT — X DOBAIT] Z2BHRL, [T
TLAEME Y T Ny = T EAEOREA ] IR ENTVWA AT AR
SOV T N 2T BRI L TWA AR LET, 7T
ZHALUET,

8 [Next] #7VU w7 LET,
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10

11
12

13

14

15

27Uy 7 LET,
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WERREINEST, =Nl A 3 5120%, [Server] 74 a2 %
Vw7 LET, P—N"EBNLZO, [Next] 27U v 7 LET,

BATHDONDS VU — %R L, [Next] 227V v 7 LET,
Migration Wizard C, [A] 4RI NetWare 3 47 = 7 35 XL TUOYNDS
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F7201X [Nol 27V w27 LES, &I, [Next] 27V v 27 LET,
[Yes] ZBIRL7I-84 . BITHED NDS 7 U — L BITIL0 NetWare 3
Y= NCEBE L2 —TEANRHLNE I DBRBINET, BB
BREREIN, B Liza—VET ol "Ne~e—UT 008950
FIBINTE T,

Tuyxl NEfERL TRIFT HICIE, [Create] 227 VU v 27 LE
j‘o

TuYx FERERLUTRET S L. BATREOLIE DM 2 7=,
e =T —on IR ERES IV ET,

THE12 T [Nol #7271V v 7 L7=GAIF. Y OFIEELFETETI,
15—y Bifr7vny=7 o5 b IEATLEIN, F
IR 12 C [Yes] #7271V v 7 LEGAE. WOTFNRIZEA T EI W,

ROVERZFATLET,

15a [Browse| h¥ > %7 U v 7 L BITHEDO NDS > U —D NDS =
T EERLET,

Migration Wizard |£, IR L7-a> T FBLNTXToOH T3
TTEMRBELT, —ETHNDS —F4EHmHLET,
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15b VU —ZZMWLTNDS 2T T ZRIRL, [OK] 27U v 7 L

*9,
15¢ B L2 —V L4 OMBE MBI H120E, Next] 227 U w27 L
*9,

15d L2 — L0 FEZRELE T,

R OWHE X, Migration Wizard ([ZE/R SN D L2 —HFHT—T /LD
BITY, ZOmEEHERLET, ZELRWEGAIE, NetWare 3
=R, FRIN TS NDS 2 —F L HBNIcv— Y S E
ﬁ—o

1 NetWare 3 A—HEE#H L= NDS 21— DY —2

Matchup Existing Users

Source Server/Domain:  BINDMDS1

Novell

The listed source user will be merged with the displayed MDS uzer. To change the displayed
MDS uger, click the MDS uger name. From the drop-down list, select a different name or select
Don't merge to not merge the source uzer with any of the listed MDS users.

Matching User List

Source Lser Name WDS User Mame -
DaVETESTOZ2 L& E TESTOZ users Mowell ~|_|
USERDZ2 USERDZ users.Movell

RIGHTSUSER RIGHTSUSER. users.Movell

DAVETESTON DAVETESTON. users.Movell

LUSERO3 USERDZ users. Movell

USEROS USERDS.users. Movell

LSEROE LUSERDE. users.Movell

USERD4 USERD4. users.Movell

USERO? USERD?. users. Movell

ﬁjm TIRERM riears Mewsall _}E

< Back I Mest » I Cancel | Help |

% NetWare 3 = — W 2O T, KDA T a LV EBRIRTXET,
¢  NetWare 3 =2 —HE2FRIN/ZNDS 2—HL~<w—TU7F3%

T —TIICEREINT NetWare 3 =2 —H 2 FDEFE LT
B&E, ROa—W LR E 9,

¢ FIRENTZNDS 2—HLSANDNDS 2—H Lt ~v—TU9 2%
NDS =—HVZDRICH DR Z 7 ) v 735 L, ZDITD
NetWare 3 = —H & [F U2 —H 4 2 FH-2>9 X TD NDS = —
P (arTFANEET) ORey XU X RRER
SHET, WTHINDO NDS £ 2#EIR L, KO NetWare 3
2—WIERFET,
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¢  NetWare 3 2 —H % DO NDS 2—H & H<w—T LN

Fay7Z o) R NMIERRINDHTRTONDS =—H

2N, ZDITD NetWare 3 —H L [d]— A TRWEEIL,

NDS —H 4 DOHIcdH HKHIZ 7 U~ 7 L. [Don’t Merge]
7V w7 LET,

15e ERIN TV A% NetWare3 2—WIZx LA TV a U AEIRL
72 %, [Finish] #27 VU >y 7 L¥7,

NDS 22—V 4T V=7 b E~—TF 25 K 5 ITEIR L7~ NetWare 3
a—WiE, Fay X Lid7 Y= kERBEIZ, BITHED NDS Y
U —IZHBIMICERENET,

WoEray (BIT7aYxr FOET L] ICHEEATLEEN,

BTJooozo FOETIVE

1T & A EDIEEIT [Project Window] TiTW\ E 9, [Project Window] T

1Z. NetWare3 DA L HZ VATV 27 "BXORY 2a—2T5—% %

ITHRONDS Y U —HNIZHDNDS 2T FIZRT v 77 RRr vy 7T
=FET,

%72 [Project Window] TlE, FEEOBITAHMGT DRI, SE £k
BATOV T VA EET LT D2 N TEET, BT —D3 oA
VATV bEIORY 2—5F—% % [Project Window] 7=
W2, BATH90 NDS Y U —{% [Project Window] OAMNIZFE RSN ET,
[Project Window] TOBATEIENIT X T, A7 74 TITWET, OF
V. [Project Window] TIERSBENZ1To7-HEIL, BITZBGT 5 £
T, FEBRIZIIBE E I ER S E T A,

BiT7a Y =2 FEERT 5D &, [Project Window] 35 O [Using the
Project Window] ¥ A7 v 7Ry 7 ANRFRINET, RO,
[Project Window] @ FHIZ#&K R E4 5 [Using the Project Window] %A 7
0 7Ry 7 ZADOHFITY,
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2 [Using the Project Window] #4 7R4 Ry o X

Uszing the Project Window

3.x Server

.3: Bindery
E Yolume Contents

3 Bindem
=B a1

1] Drag and drop items from the zource server to a location in the destination tree model.

2] Select "Vernfy and Migrate' to begin the Migration Wizard and commit the modelled changes.

3] Far more detailed help, click the Help button.

[~ Show "Getting Started" when starting next project Qlu:usel Help I

FRBATTO V7 MIHLT, ZOXA TR IRy 7 ACEKREND 3
ODOHEAFNEZFATLES, EMT T2 FIHLHEM LIS, [Close] &~
Y27 LT [Project Window] #F& 7L, BITOET M LABRBLET,

WOIEEEFATLET,

1 2 —9 5 NetWare3 XA U XU ATV x/ heARY a—LT7—H,
BIORav—R&ich 3878y —XONDS Y U —NDOa T F &k

FELET,
2 YEZIS U T, BITHEDONDS VU —IZH L WA T V=7 FEER L
F7,

¢ HLWNDS ¥ (27 F & HEEN D ) 2 1ERT D 1iE, H5
DOXT L bharyytaaE7 0y LET,

o HLWT X EERT DI, BEO T +LF F TR
Va—2%&E7Y v 7 LET,

3 NetWare 3 DA L XV FT o7 b, THNAE, BIORY 2— A
ZNDS a7 FICRI v I7 T FRay X LET,

Rov7vay [(BT7my =2 FORGEE IZEATIEEN,
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#1700 ) FDOEE

[Project Window] THATHZ#ET /WLLIZL, ZRHDH LA T V=V
~OFEIE & UCTHRIE LICFTAS, BATIENDS ¥ U —NOBEF D4 il
EHAELTWRWNE I DERGET DHLERH Y £,

KT 77 RRay 7 UEHEBIZNDS VY —IZERENETH, =
NHOEAX, NDSY U—NOHBOZY 7T ~at —357=bD %L
LTED Y TONTWAETTHAZLICHEREL L EE N, 7 V=
7 M, BITERMGT 5 E T, EBRIIBITESNEREA,

BiiouYzs beETMELTIED, A RT v ORGEEY 4 F— K
EIITCTEET, o, BIEEBATZRIFHCFET T b TEET,
BATORNCAZ  RTa  ORGEY 4 ' — FE2FATT L0 EITH Y £H
A, BATEZBIMRT DANCE KT 7 —B8E 2R LT &, BT
BEORRFE 7 1 & R T DN E L 72 0 £,

1 AZ 2 RT7aVOREGEEY ' — R&2FAT73 5121%, [Project] >
[ Verify Project] DIEIZZ U v 7 LET,

2 KOEI vy 17T X—=VDIBITHDONDS V) —~D—H L F—
2 DOAT] T3 2 FIH2 »HBRE L E T,

BITEDODNDS Y —ADA1—HET—2DBT

NetWare 3 7—# DA E—l72 5KV a— 2B X Oa 7 Hid@wR L
FLEN, T—XIXEEBITEIN TV EY A, NetWare 3 2 —H 47
Pl FEBITTAE, NDS ATV MIEHL S, BITSED NDS
VU —IZRESNET, BITERMGT HI2IE, REFITLET,

1 Migration Wizard @ —/L/3—"C_ [Project] > [Verify and Migrate
Project] DJEIZZ U v 7 LET,

FE:RIEP. BITITO NetWare 3 H—/NEIZHLWNLM 774 LA % S & @A
SINFGEEICIE. TOT7AIERHITHILELNHYET, IJ7MILEEHT
B2, FDT 74 I)L%E Products¥NW3X ¥4 LY Y HhibaE—LZET,
Migration Wizard THERSNIZNLM 7 7 A LIZIFEIE—F B L SITFELT
{f2&L% NLM 27 A LEaE—LT=%. BITTD NetWare 3 H—/\% 1) T—
k L. Migration Wizard #BEETLEY,

Products¥NW3X 7« L' k1 [&. Migration Wizard D4 >R b—JLEER L
T4 L% k1) (C:¥Program Files¥Novell¥Novell NetWare Migration
Wizard¥Products¥NW3X) IZH Y £ 9,

2 YmiE OB Z A, [Next] 227 U v 7 LET,
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3 CRBUC ko THET) BEO P — % BITT 2841, BITT 20—
RONEFESR L, [Next] 227U v 2 LET,

ZOBER, BEOBAT LY =AM Ta—Y AT V= FAEBEL
TWDLEEITITFATLET,

4 a7 IRFREINZEDS, NetWare3 7Y U Ffa—R U 2—240D
BATHRIZIR DAY 2— L% RINL, [Next] 27V v 27 LET,

5 HLLEK LI-a—VIH LT L— b A7 V=7 bafd
LA, YV —%2BRL, YV —Ea—nbTrTL— R FT
VxJ FNEBRIRLT, [Next] 27U v 7 LET,

T — b EF TVl FEFEALRWERIL. Fav IRy T A
A7\ L7T [Next] 27V v 27 LET,

FE:R—LT4 LY MYIE, BEMIZEBITEINEEA, R—LTa LY Y
#B1ITTBICIE. R—LFa LY bUDHSB NetWare3 T4 LY M) #581T%
DNDSVY—IZKRSw T 7o RROYTF20ENHY ET, RIZ. NetWare
3A—HEBITHRONDS V) —IIBITTHEEIC, ToTL—ETPzH b
EFEALET, CDEE, FUITL—rATPxH FTHELEER—LTAL
J RUDISAM, BITHEDNDS V) —NTNetWare3 T« LI bUZE ROV S
FTHEHERLTWS I EE#HRALET,

Evbh: ZAETITTFUOIL— ATz bZERLTOLEGELA, ZZTHERA
FTAHBEICIE. TP H FEHRFEL T, ConsoleOne #BE, T L— 4
Tz bEEBRLET, RIZ. Migration Wizard #BEXE{T L. [Open Last
Project] 22U vV LET, BITFIEZ 17T X—CDOFIE1 hSBREALET,

6 BATIcDNetWare 3 — N EBITHONDSY UV —CEHBET L7 71V
DM FEEZEELET, KOWTANERERIRL, [Next] &7
Uo7 LET,

+ [Don’t Copy Over Existing Files]
+  [Copy the Source File If It Is Newer]
+  [Always Copy the Source File]

7 Z @ NetWare 3 —"DBAITE MO TIT 2 BAld. [Yes] > [Next]
DIEIZZ Vv 7 LET, LURBIOBITEE I 25E81%. [Nol >
[Next] DONEICZ Y >~ 7 LET,

NetWare 3 D2 —H#FB LN IL—T%2B1T715 &, NDS 4 &2 FHOo%
BATIE — O o HE VT —T AR ESNE T, 07—
JViX, NDS YV U —IZBAT 472 NetWare 3 = —H & B Hh T
VWEJ, Migration Wizard I3, & D7 — 7 /W2 —HF OBITH: & 7tk
T57D, DEOZ—VFE2EHENI T TBITT 52 ENTEET,
F70. BITEREOBWAKMNT S ZLICED, ELWIZ 7 A LDT 7
Y AMENEY) e —PFIZE Y B THERET,
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8 BATHONDS Y U —DN_AT—REZASL, [Next] 7V 7 LE

9

10

11

12

13

14

15

D
BATIEY — DA T —RZ AJJL, [Next] 227V v 7 LET,

BEOYP ="z RRHIBITT 25613, BT 5T TOBATT
P— K LT, ZOBHENARRINET,

[Next] #27 U v 7 L, NetWare3 7 7 A /LY AT L&KM T D28
(LTI T 4 AT REN, BITHRORY 2—AIlH D L 2R L
F7,

Migration Wizard I, Fr v 7 EN 74 VFORREAX v L,
INHDT FINEEBITT B2 D RN B8 9wk
SELET,

T T ERFRSNTGBET. AATRRRDATT V=7 FEIT
DAFIOBE R L, [Next] 27V v 27 LET,

HATHRIDFT V=27 NOLBIEERT DN, ZOLHI AT
Vxl FEBITLRVWDERINTE 3, #HEOV—EREFCE
ITT2%561%, BITT 2T _XCOBITTY— NI LT, 2 OMEH
NERINET,

Ty ERERINTEEAT. XA TNELAT V=7 FETO
LD wA R L, [Next] 227U v 27 LET,
BATNREILAT V2V hoe~v—950h, 20X TVy
MNEBATLZRZWHERINTE T, BEOV— ERRKFICBITT S
LA, BITT 5T _XCOBITEY— NIk LT, ZOMEENAER
IhET,

BAT LW NetWare 3 T —HFRERENTZH, T2 MR L. [Next]
7 Uy 7 LET,

BATT 52T X TORBITIRY — T LT, ZOEEPERINET,
R0 NB o T2 E X, [Cancell 22 U 2 LT [Project Window ]
RV, BT 4 52—V &2 RT vy 7 FRry 7 LET,

BAT LW NetWare 3 7 V—T NERREINZH, TN EMERL.
[NeXt] %7 U “/7 Liﬁ‘o

BATT 2T X TOBITIE— NI LT, ZOHEENRRRINET,
M N o7, [Cancel] #7 V > 7 LT [Project Window]
WZRY, BT T 52—HE2 N7 77 FRry 7 LET,
BRI =%k L, [Next] 227V v 27 LET,
BEELFERTIIRNT T —i, BITRICHERTE T, ERR
T —FFEEEARIT DI, =T —DTFIZHDHTFA R
74— RICFRRENTHHETAE T, ZORBICE, =7 —I2
DNWTEZOLNDRK L, RO DDOE v FPRINTNET,
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16 KOWTNNEFATLET,

¢ ZORRT, 7Yz Z FORREET 2T TV D AT,
[ Verification Summary] % ®&t7~, [Finish] #27 VU v 27 LT, 17
R=TD [BATHDONDS YV —~Da2—H LT —XDBIT| O
FERICHE» TEBOBITZHBLET,

o ZOEET, EEOBITEITo TWDEATL. [Verification
Summary] % i, [Proceed] %7 Vw2 LT, BiTAKATL
*9,

17 (BITOBEDOHR) =7 —u 7B I Oe VBEREINET,
WDt 7 vay TBITHROEEDTEIT] ITHEA T EE N,

BITROEEDETT
RAENF TV 27 FBEONT 7 A4 VY 2T MEBITHEY—ITBIT
L7cth, WOIEEEFITLET,
Q % =2—~<_—2OH% NDPS® (& #9 2381%. FIRORE4 2 H
LET,

FEMBIZ DU TIE, Novell Documentation Web 1 b (http:/
www.novell.com/documentation/japanese/nw5 1/docui/index.html)>
[ Additional Documentation] > [Print Services] > [Novell Distributed
Print Services] #Z ML T 7Z2& W,

Q7700 —2a TR ELSFE TSN L 2R LTS
AN
BATth, *y MU= BBV —E R %A VA M= LGRS
Yetx, [Novell] 74 =2 > [Install] ONEIZZ Y v 7 LTH—
by TN A RV BTWVET,

Q BITLzS2—WIZ, BITHONDS Y U —iZu A 957 0DIE
LV Novell Client 70237 4 3% Z & iR LTS IZE3 0,

Q NDS VU —HNOHHLWT —ZDOGFNIT 7 EAT&E L L9512, 22—
YarsA A7) eERLET,

FEABIZ DUV TIE, Novell Documentation Web H1 b (http:/
www.novell.com/documentation/japanese/nw5 1/docui/index.html)>

[ Additional Documentation] > [Novell Clients] > [Novell Client for
Windows] > [Setting Up Client Login] > [Setting Up Login Scripts] %
ZRLTZEN,

Q FA—2741L 27 MUZBITLTWRWEEIE, BEY TEITWET,
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NetWare 4. 5. 6 ™oL DT—2 DFBAT

NetWare® 4. NetWare 5, F72|d NetWare 6 0)"5‘*—/ S5 BIJD NetWare
P— T —Z ZBATT 5 & E1E. Novell® NetWare Migration Wizard 6 (Z
L oT. BITEY — DT 7 ALY AF M35 ERNDS® 57— 4 R 28,
LA A M=V LTEBAITHED NetWare r— N ICa B —ILE T,

BATIEY =D T 7 £ LY AT K5I LUNDS 74 = 2 BV BAT
P—NIBIT SN, BT — S HEIICIEIE L3, BT
YP—rF V7= L, BEOR Y T =7 ETBATIEY — DA &
BTGB G| & kD3 E T,

Existing
NDS Tree

replaces
and
: assume
NetWare the 'de
Destination Server

Source Server

Temporary
NDS Tree

Temporary
Server Name

T =X #BATT DN, T K72 NDS ¥V U —WNIZBATHE D NetWare
P—RE A A F**ll/ﬁ“ébﬁﬁ)&) DE4, —ERRRY U —2i%, Y —
NPT DT HEMINTWDEY Y —TF, ZOH—,NL, NetWare Dk
AA VA=V ZTOT, BIMORLE (SMS™ DT 7 1 kD
W ER ) DA VA F—= L ER TN — T,

NetWare 4. 5. 6 oD T—2 D17 21



NetWare 4. NetWare 5. NetWare 6 7255 — X #7173 5121%. IROVEHE
ZNEFICFEITLET,

1. 22X—=UD VAT EL Y 7 by =T EEOHE )
2. 25— @ [Migration Wizard D F1T |
3. 32—V D [BITHRDIEEDFEIT]

VATLEHEVI MO I TEHDOES

D—ORT—23avz#KT D

U—J AT —3a VINROFBEREIZL TWDH I EEMHMRL TS
Uy,

Q SOMB LA EDOHERARIEERT 4 A 7 FED H D Windows 98 F 721X
Windows NT 4/2000 UV — 7 A7 —3/ 3

* Windows 98 UV — 2 A7 — 3 g > ClZ.Novell Client™ for Windows
98 N—T a3 33 LA FITL TV OIMNERSH Y £7,
EE : NetWare Migration Wizard 6 [£. Windows 95 7J—2 X 7— 32T
[EETTEFEE A

+ Windows NT 4/2000 V — 27 A7 — 3 a3 . Cl&. Novell Client for

Windows NT /3—3 3 > 48 LI AZ FITL TV ARERH Y £
ﬁ—o

O NetWare4 2> 58179 58513 IPX™ 7 2 k =117 Novell Client 7 —
JAT—2a VTREINTND I &,

Q N7 xr—<rREMRLETDHITE. BITT— BITEY—R B
TN FGAT U N— T AT — g o HEBOLAN® S A b E
THEITTH L HHERL 4,

BOTY—N\&EET D

BAToo Y — Nk, BAIT4ED NetWare P — Nl Zabv—Shb 7 7 A0, K
Ja—2b, BEONDS 7V =7 MM S LTV D NetWare H— 3
Tt AT — /33, NetWare 4.11, 4.2, 5.0, 5.1, ¥7-136 %
EITLTWELH— T,

Q ConsoleOne™ ZfEH L, BITIE—EZDT 7 A VT AT LITKE
LCA=INANAVHERS DL Z EERAELE T,

Q H#Hr? NetWare Support Pack Z i L TRATICH — " ZEH L 7,
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581D Support Pack |%, Consolidated Support Pack 75— 22— (http:/
/support.novell.com/csp/csplist.html) 7> 5 AFTE E 9,

QO CRIWIZE - THEIT )NetWare 4 26T — X EBATT B56. BITx
P—NTlE, 2 E—ENDTRTORY =2—2Ah| ﬂbf D/7
XL AN=ZARYPR—=FENTNDZ EZHERL T EEN,

NetWare 4.11 £721% NetWare 42 DR Y 2 — A2 2 7 R— 5 AR—
ADYHR— FEBENTDI0E, P—/2 Y —/L T [LOAD LONG]
L ASIL. &Iz TADD NAME SPACE LONG TO volumename] & A
HLES,

O DSREPAIR #1— KL, KD 3 DDA T v a v &EFEITLET,
¢ [Unattended Full Repair]
+ [Time Synchronization ]
+ [Report Synchronization Status]

INEOFTarN, TR LIETLEZ LR LT
él/\o

O NDSBIO®ITRTOT—HE N0 7T v LET,

BORY—N\EEETD

BATHEY — N, BT o — T — ¥ 2 TRA L a v B a—
HTT, BITHhRY— "%, —WHR2Y ) —ZAf VA =T HLERH
D ET,

BAT Y — "I RBATR Y — 2T — 2 BBAT SNk, BTV —
1TV 7 —hkLEF, ZDEE Migration Wizard (210 . BT — D

AUTOEXEC.NCF 7 7 A VN HEIICE R S, BITooh— D45 &

PR IPX™ K5 / — R ID NEZIAENET, TNoE TFEITERTS
MEIIH Y FHA,

ARILBATH Y — N3, NetWare 5.0, 5.1, £72136 #FITL TN Lo ¥ —
/3T, Migration Wizard TiL, Netware 4 1 — ~OBITIIEITTE E
A,

*Zﬁﬁ'ﬁ"f**ﬂ NetWare &L —F 4 VIV AT LA VA M—)LT %
AT, ROMEEZRER L T2 &0,

Q ConsoleOne i L, BATHY —NREZDT 7 A LT AT AR L
TA—INNAYHERDDL Z L RAELET,

O —BAY72 NDS >V U —& 2R LT, —I 72 NDS VU —Z21/Epk L =
kR
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EE: —HBHEELTTS L U—BNAENDS V) —2lE. BITTY—/\OLRTE:
[ENDS V) —& ERLAFIZLGEVTLL SN, ALARICT 5 &, BTHE
12, BITAY— /1 \DABOTTY—/\OHAERESISREFTEA,

O A A M=, BITES—AORY 2— AR ENZREY
REWY A ZDORY 2 —Lha2BAThV—NITER L £ 7,

BATHRY —OFERY a— 2413, BT —DOKRY 2— 14
ERICICT2RER DY 7,

Migration Wizard TiX, EMER Y 2 —LOBITHITRAE 7. EMR
Ua—LbzIEMRY 2 —LIBTT 556, TORY 2—L1F8
TR EMEMERR S IVE T, BT O Y =2 — AR EMMRER S i & &
(BN wmD BATHROIHEMR Y 2—LH D Z L 2R LT
STZEW,

O NetWare 4 2» 58474 5881%, IPX 70 ha)lz A A =L LT
HELET,
BATHFATT HITIE IPX 70 b I ARBATEF — N A o RER
TWOHDMENS D F3 (BTN T T HuUX, IPX IFHIBRTE £7),

BE . BAXY—/1\DIP7 FLREBITINERA, IPT7 FLAOEBEDFHH
IZDNTIE, 28 R—UDFIE3 EZBBLTLESLN,

Q Birky— Nz, EHT D NetWare ARV —TFT 4 VT VAT LEkA
VA=V LET,

* NetWare 5 DA A b —/LHFIEIZDOWTIL, [NetWare 5 22 & A
v A k— 1] (http://www.novell.com/documentation/japanese/nw5/
docui/index.html) ZZ M L T 723\,

NetWare 5 DA > A h—/LEIZIE, [Additional Products and
Services] ®[HC [New Server] 47 3 V&&R L. SMS LIS+
DOEEDF =2 v IRy 7 AT _RTAE7ITLET,

* NetWare 5.1 DA A b — /L FIEIZ DUV TIL, [NetWare 5.1 A > A
k=774 K] (http://www.novell.com/documentation/japanese/
nw51/docui/index.html) # 2R L T 72 &0,

NetWare 5.1 DA > A h—)LERHZIT, [A v A N—NF 7T 3]
W THAZ LA T a BT, SMS #FR< ., SRR AT
AL OTF =y IRy IV AT _RTAHZIC L ET, EINFFERR
TERWT 7 3L hOBIIZHOWTIE, FOEETRIEDLY £
A,

¢ NetWare 6 DA > A b — L FIEIZDOWTIL, [NetWare 6 #F22 & 1
A=) BBRLTIIESN,

NetWare 6 DA A h—/VIKHIZIE, [~ A 7 L—3 2 ]
V=" F T a e TERIRLET, RIS, BITTV—30
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TR RN T DI DI B R RENBITR Y —NZH D0 E
AMERIETEXA LI, HAXLLET T a BRI ET,

WRD& 7 > a s Migration Wizard DT IZHEA TS EE W,

Migration Wizard ®3E1T

1 Novell Software Downloads Web ¥ I+ (http://www.novell.com/
download) @ [NetWare] =727 2 a > » 5, NetWare Migration Wizard
6&F 7 m—RLTA A=V LET,

2 (A M=)V LT & Migration Wizard % F1T L £ 97,

TI7HNETIE A VA=A T BT TAIES>T [RF—F] A
=a—> [7m 77 A] > [Novelll] > [Netware Migration Wizard] >
[NetWare Migration Wizard] |Z Migration Wizard 723 > A h—/L Zj1
£

3 WmiE OB 2 HA, [OK] 227 U v 7 LET,
4 [Create a New Project] > [OK] DJEHIZZ Y v 7 LET,

5 [NetWare 4]. [NetWare 5]. F721% [NetWare 6] DOV § 417> > [OK]
DNEIZZ Vv 7 LET,

6 [View Setup Tasks] "¥ %27V w7 LET,

XKV, T ED Web 7T U NEEE) L, NetWare
Migration Wizard 6 DA > 7 A L~V 7R & £77,

7 [Migrating Data from NetWare 4( £721% 5, 6)] #& L, [ A7 A8
fRe Yy 7 hy =T EOEG ) ICRHESN TV VAT LB LT
TR =T BRI LTSI LR LET, YT UV EMAL
S5

8 [Next] #27 VU v/ LET,

9 Yuv=s NMIARIEMT., BRIFT D52 @I L, [Next] %7
Uy 7 LET,

7 7 4/ h Tld, C:¥Program Files¥Novell¥NetWare Migration Wizard
T _XTo7Try e/ MPRGFINET,

10 BITeh—"DH 2L NDS VU —%3& IR L, [Next] 27V v 7 LFE
KR

11 NDS YV U = OBITIE— 28I L, [Next] #27 U w7 LET,

12 BT —"DH DL NDS VU —%8® IR L, [Next] 27V v 7 LFE
KR
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13 BATSEDONDS ¥V U =6 BATH I — "2 @R L | [Next] 27 U v 7
LET,

14 7oy =7 F&EHEF L, [Project Window] (27 7 & A4 5120,
[Create] #7 U v 27 LET,

[Project Window] 723#7R S E T,
WKDOE7ay R a—AhDabt—| ([ZH#EATIEEN,

7 : U d _-/-\0) - l:o_
1 [Project Window] T, [Copy Volumes] %#7 U v 27 L¥7,

~A V=T ar U4 P—RTE, 77400 a v —%tET 500
. TAVIZ RV ET7AND N T AT A DRI T v 7S, B
T — "B LOBITEY— D7 7 A4 MR FESNET, NDS
DTN TTHE, ZDOT7ANNS N T AT 4 DN EBEEIN, B
et — NI S v E 7,

FTRTORY a— A% —fECa b —FT AL TIHY $HA, BfED
E—d AMENHDLRY 2 — LT HERTE £, EY DR
Va—Aid, 8 C7avcl N7 7ANVERERNCaY—T52
ENTEET, BVWTWE 7 7 A MVIBITERARVWOTEELTL
7FEW,

BFE: RN 1—LEEHEIHHTTIE—FTZ5EE. REOIE—KIZ. Th
FTCOAE—LEZFIRTORY 2—L%EERLT [Cancell] 29 Uv I LET,
COREEETLEVWE, BRRICAE—LEERY 2 —LIZRHLTEF, FSX
FTAEYLTHETINET,

2 XA 4=V EDOERY a— L2485 8K L, [Yes] £721%
[Nol #27 VU v 2o LET,

EORY a—2rbabt’—LARWNEAIE, TXTORY 2 —2T%H L
T [No] ZIRL., [Next] #7 VU v 7 LT, 28— [EEH
ET 7 ANORE] [CERET, 1 DL EDORY 2 —2IZx LT
[Yes] ZER L7581, TIA3 I#ERE T,

RN 2 — B REWGE, LAN i O#ENEWG S, 703817
T —ROBRIPND 7 A NVZIFFEDT 4 V7 B EBHLTT —X
EHRETAIHEIE. N T v T —TEFEHL TR 2a—2%
a—F5ZEERIHLTLIEEN,

BE:. TNy o7y TEERAT HI5E. NetWare A RL—F 4 VIV RT LA
FERN—Sa VT T I L— KT B EEICE, BITTY—/\DIZH SYS:
T4LY M) EBTEY—/NIZETLELTLEEL, SYSISYSTEM 4
SYS:PUBLIC M & 5 44 SYS: T4 LY b U (X, NetWare DA VR b— /LB
IR EhTLET,
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BEODT—2EFE2HLILWN—FEY T 72T L. NetWare D/N\— 3 VI
BN WMERIE, BITTY—/\OBESYS: T4 LY M) EBITEY—/NIZET
Lij-o

TNy T v TN 55613, [Select Volumes to Copy] [H
HTTRTCORY 22—k LT [No] ZIR L. [Next] 7
Vw7 LT, 8-V 0 [RERIEY 7 A VORRE] IEAET,
BAT T —"DESYS: T 4 L7 b U BT — "RDSYSIMIGT «
L7 RJiZabe—d32a2nEr20EEEL, [Next] #7J v 7 LE
R

Migration Wizard TlX, BTV — D SYS: T 4 L7 hU BN EEE
INDHZEEHY EHA, BITLT—OKSYS: T4 L7 U &
BATT 5 Z L 2RINLTGA L. BITE Y — 30 SYS:SYS.MIG
FA4L 7 FVIIBITEINET,

BATIRI =3O SYS: 74 L7 VT, BATHY — S THHEMAT D
T ANDEENTVWDEEIL, NDS OBITOE T4,
SYS:SYSMIG 7 4 L7 R Unn, BT — 07 SYS: 7 «
VI NUICHER 7 A v E2ae—LET,

ZOTFT 4L RUVIINLM 70 Line57 ) r—ya silo
WTCIE, BATRIZEHA VA M= AT B3XERHD 9,

BAT T — N EBITHRDONDS YV U —CTHEET D 7 7 A VL4 O
EERELET, ROWTHNZERL, [Next] #7 U v 7 LE
R

¢ [Don’t Copy Over Existing Files]

¢ [Copy the Source File If It Is Newer ]

+  [Always Copy the Source File]

RN a—2bDabt —FHEEHREL, (Next] 27V v 27 LET,
WD2ODFT v a UinbLBIRTE ET,

+  [Copy volumes with users logged in]

¢ [Disable login]

AT b=y a = RTIE, D TWna 77/ Lidar—a
nNEtA, 2=V /(2 8hT5L, 774D ab—HE,
MoOZ2—FIERry "=~ 7L LT, Z7ANVERL ZET
TEEHA,

6 BTty ) —BXUOBITHEY ) —D 2T — &2 AL, [Next] &

7V w7 LFET,
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7 T T ERFREINTEHEAIL. BERART T — F TS R L
[Next] #27 U v 7 LET,

8 VANV AT AERBITHONDS VU —lca bt —3F 51211,
[Migrate] #27 U v 7 LET,

9 =7 —u/BrOIr V&R L, [Done]l #7 VU v 7 LET,
WD ay [BERET 7 ANLOHE] ITEATL Z X0,

RIRERE 7 7 1 ILDIRE

1 [Project Window] C. [Edit Configuration Files] #27 VU v 7 L¥79,

Migration Wizard Cl, {754 — 30 NCF 7 7 4 V< .CFG 7 7
ANVEERETEET, ZNOHDT7 7 AL, T 74/ h®d LOAD
AT =R AU RERTA—=EZRNEENTWET,

ZEE : AUTOEXEC.NCF 2% 7 3558 1F. BT NDS FT—E2R—X 8BTS
BIZZ274ILERALEY,

2 TXARMRY I AT, WETIEREHREY 7 A V&R L, [Edit
File] #27 Vv 7 LE7,

3 BT —ROBRERET A AN L vy Rea— LT, BfT
T — N2 DG T DRERE T 7 A MO 4, T L
72 6. [Save] > [Close] #27 U v 7 L¥d,

BATHY—"OIPT FLAZER LT, BiTh—DIP 7 KL
AZERCICT AT, BERE 7 7 A VEREL, IPT FL 2%
ERLET, %L D7 74 E. AUTOEXEC.NCF 8L O
SYS:ETC¥HOSTS @ 2 > T,

BATTY—"DIPT RLAZab— LT, BT —0
AUTOEXEC.NCF 7 7 A JVIZHE D 11T £9° ( Z OEAEIE,
AUTOEXEC.NCF (Z IP LOAD 27— s A > M B X OVBIND 27— b
AV ERRBRENTODHEAICETITOET), SO —
NOPF—Rz3 Y — L5 SYS:ETCY¥HOSTS 7 7 A MZEiik &
TWAHIPT RVAZERTLHMERDY £7°, BT —XDLD
ARTERELET,

IP 7 FLZDE|Y Y TIZ INETCONFIG {3 584813, BITH
SETLTOLIPT RLAZEELET,

4 CRPLIZ L > TEIT)REFHAD X A LY — A (TIMESYNC.CFG) % fifi
HT 58813, BT — 30 TIMESYNC.CFG 7 7 A /L7 6 |
R ®R A2 22— LT, B4 — 3D TIMESYNC.CFG 7 7 A /L
WZRE D AT £,
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5 [Compare Configurations] %A 722Ky 7 ZA%HLET,
wRDE 7 v ar INDS ODBITORM] IZEATIIZE,

NDS D #1TDE4E

1 [Project Window] T, [Begin NDS Migration] #7 U v 7 L &7,

2 BITLRWARY 2a—2&F_X TR I 7 v 7L, ROEEEET L
Tinh, BITEHITLET,

o FARTORY a—AF—FBEL BTSN & 2RERLE
ﬁ‘o

¢ TFANAE—IRIRELLEERRE T — 2T N THRIRLET,

¢ BATILONDS VU —WIZdH 58— SORFZIFEH LT T,
NDS AREHULEN TS Z L 2R L £, sHMIIOWTIL,
3 N—=VOFI2 ZBR LTS,

3 [Next] #7 U v7 LET,

4 TABVAT A AT EFHAL, 74 RAZETET 74 L~DX
AZMBEL, AL Th B, [Next] 27U w7 LET,

MLA RNHAEEIT. SA BV AT 4 A7 2FAT ALY I,
MLA Z8IRT A L TEET,

5 [Yes] F721% [Nol] #EIRL T, BIToxV—ORAF—<ZHHL
9,
BAT I — DA F—<DNEH S, BITHES— N2/ 2 h—L
SNABTFIHNENDT TV —2 9 DNDS 7 7 ARV AEN F
KR

F 74V 8T [Yes] TFVFRE B4 N> THETA, [Nol
PERTH L, BITLERBITEDAT—< R INET, 2Dkt
BEFMATHE, BITOWRZT D EZICAF—E2ED L DL
T D EHMTEET,

6 HATT DRENT. 31— DO FE2IZHP] &4 TV 5 DSREPAIR @ FJiE
EETLENE I DEHRLET, ZHIEBITe— % 5& T NDS
YU —RNELHEELTWDZ EEMIET A0 FIETY, VI —
DOIREZ MR L., [Yes] £721F [No] 227V » 7 LT, [Next] %
7V w7 LET,

Y U —DIRFEA MRFET D DSREPAIR %317 L72< T, Migration
Wizard DFR AT CE £4, 72770, VU —2 R RE K
TERBTHE, BITORIELSE T LRWEERH Y £,
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7 NetWare 5, NetWare 6. % 721% Border Manager % 32179 % NetWare 4 7>
OBATT D8 E1E. NICLIRERE Y 7 A V&, BT o — bk
fTht—ica b — Ligkd s Lo icgsksnEd, mmofEmric
PEVN, NICIRENE T L6, ROTFIAICHEARE T,
EE:NDSOO—RFhFERIENICI 774 LDIAE—HRITNICI T5—MNFEEL
=88 1%. RIBITEY—/NZPKINLM AO— FEShZMNES I ZEHELE
Fo PKINLM AAR— FENBLMGEE(E, 55 R—2D INICI TS5 —) #38BLT
{FZ&Ly,

8 BAT L — B L OBATHY — Tk 22— V86 (B ) %
FTRTHIBRL, [Next] 227 Y v 27 LET,

9 BTV U —BLOBITEY ) —D AU — K& AL, [Next] %
7V w7 LET,

10 [Migrate NDS Verification Results] i CHEKQ= 7 —F /213 E %
gk LU, [Next] 227U v 7 LET,

11 [Migrate] #7 U » 7 L, NDS OBATZ B L E7,
COBITTRRARKT oL, BAT R — MR L, BT
P—= Y 7 — F LT, BATIC Y — D4R & RBIE REAT I
P ZHlE BN E T,

Migration Wizard Ti&, #1745 %— 30 AUTOEXEC.NCF 7 7 A /LN
D, WOHBPHBRICEREINET,
¢ T AN =D BT — NOARNCER SLET,

o HA LY =B BATIEY—/30D AUTOEXEC.NCF 7 7 A JLICHE
WENTNDHA LY —NIEHEINET,

o  HY—NID D, BITTY —/3D AUTOEXECNCF 7 7 A JLZieah
INTWD IPX ONEF v MEEZIZV—NIDIZEFEINE
R

¢ TITANIDEA LY —=NOXA TR, BT —D
AUTOEXECNCF 7 7 A MZEIB SN TV AEICEE SN ET,

o NRNAUFYarsxR IR, BT —/30 AUTOEXEC.NCF
T A TR ENTNENAL U F Y arTHF A MIERSH
9,

BE: BAKICE., BOTY— \ORZRAAEREEBNIBITShEEA,
12 =7 —u 7Bl U0Hn 7 & L, [Done] 227V v 7 LET,

Ii—uﬁ%ﬁﬁﬁék\@ﬁﬁm%&btﬁ&f@zﬁ—%%%
T&FET, =T —N"RAELTWEESIZ, e /2 FH LT, —
7 — ﬁ%é?éif@ﬁ#&@%@@ﬁbtﬁ%%mbi?o
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NDS OBATICRB L2 HBAIE, 56 X— 0 INDS OB1T] 25
LT, &V —NEIOREIETLTT D HEZHREL T ZIN,

13 BT LTHRE LI — "2~ ZoV—"Z2HEHL T, B
T —DOAFINGI PN TND Z L 2R LET,

14 V—J A7 —varv&)7—FrL, BT LTHRELEZYV—Z
oJ A4 LET,

Oy A TERWESIE, 25— (U= 25— 905
=D EBRLTLIEEN,

WDt 7 a INDS DBITOKT ] ICEATIIEIN,

NDS OFBITDRT

1 [Project Window] "G, [Finish NDS Migration] %7 U v 27 LE7,

2 [Continue NDS Migration] [Hi[fi DOFHH 2 Fidr, KD Z & ZHER L T
STEEW,

*

BATSE L LCIRTE L — SRR L, BATIES — 304 i
B L OMBIEEIE XM TN B Z &

TARVABAL VA R—LENTNDZ L

VY —NOTRTOH— NI LT, NDS BRFEHISnTHNAE D
L

NDS ORI AT = A B4 2121, y—ary—17T
DSREPAIR] & AJ) L. [Report Synchronization Status] 7~
v a B L O [Time Synchronization] 47" a v &#EITLET,

BATH Y — NI AEZRRL TV D EHII~AZ LT U R
7eWEEAITE. NDS Y U — OO — "D 55 W hono L
7V B oY — 35 DSREPAIR #3417 L, NDS D[R % 3
RAEVBERH Y F9°,

3 [Yes] £72i% [No]l 227V v 7 LTHRIH2 TOEENRTT LIZZ &
MR L, [Next] 227U v 7 LET,

4 %

P E—

TV V—DRAT— K& AL, [Next] 27V v 27 LET,

5 s

SR T =&ML, [Next] 27U v 7 LET,

6 NDS OBATAE# T3 5HI12i1L,. [Continue] =7 VY v/ LET,

ZOBPET, 77 AND KT AT 4 BETESh, YU —HNOR
Va—AbAT7V=y bREHINET,
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7 =7—uJsBX0r V=R L, [Done] #27 V v 7 LT, B
E@7OE\‘/\‘I«7 }\%Eﬁtjﬁj‘o

WD T ay [BITHROIEEDFET) ITHEATI IV,

BITERODEEDELT
1 #4756 ¥ — 3T DSREPAIR % 5217 L. [Unattended Full Repair] % %R
LET,

2 S FIEEAE U< BTSN L 2 HR L ET

3 AU 2—ALD%SYS: 7 4 L2 ~U (SYSTEM, PUBLIC, MAIL,
ETC., 3L O'NETBASIC) IZBH#3 257 7 A VETZIEINLM 7' 1 75
LEGgeT 7V r—ya BT _XTHA A M=V LET,

BE: BAET—NEBATY—\OBINERICL >TEHFRINL D, b
DT FTVr—2a EEHT, BITEY—NEDONDSFH Ty MIFTRTHI
BREh, BITRY—/NNLONDSA TPy FMIBEETHBAONET, L. B
TRY—NOT7 T Tr—2aVIZBET S NM 055 LlKEIBRShEFEA,
FIUVr—2avEERBTBICE #HETAHNDS ATy RSB ETHDT
O, PFVH5—23vONDSA TS s FENDS VY —IZETT 3BE(E.
FIVr—2a v EBA VR N—LT2RELNHY ET,

B1T5E Y —/\T NetWare 5.1 #E17 L TL =154, SMS, LDAP, Novell
Certificate Server, F7=[% NetWare Management Portal [ZB8J 2 Z&EMNRR S
h3ZeDBHYVET, CNoDEEHIEE/EL. NDS 28T LIzT7 T Ur—
LavEBAVAM=ILLET,

INbORy NU—7 /BB IO —ERZHA A =L 51T
¥, NetWare Operating System CD (2% % NetWare Deployment Manager

2—7 4 V7 4 (NWDEPLOY.EXE) Z{# 94 %57, GUIA %
T x2—AT, = hoyTDONovel T4 a2 %7 1) v 7 LET,

4 fi D NetWare Support Pack 1 A h—/L L £7,

ZHUCEY, A A=A T LT TV = a rORFa—NE
IS CT& £9, HHrD Support Pack I%, Novell DH 7R — K Web ¥ A
I (http://www.support.novell.com/misc/patlst.htm) CAFTZ £7,

5 DSREPAIR % [Time Synchronization] #~7'> 3 > CIHITL, BITiL
PR EDOMOY— LR SN TS Z L E2MERLET,
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Windows NT ™5 DT —452 DO F%4T

Novell® NetWare® Migration Wizard 6 Tlx, =—H#B L OE#+ 5 7 7 A
NDT 7% AMEDBIT, NAT— FOEIY ST, f5E L NDS® v U —
SNONT 77 ANV AT LOBITRE, FEREENHEfLSN TN E
T, T, HFIEEEFEITTHODO2—T 4 U T 4 ZEBNERIRNY
HUETH D A,

Windows NT 3.51/4 NetWare
Server Data Server
/ .
- File System
an
NT Objects
L J

NetWare
Migration
A Wizard

Windows NT 4.0 Workstation,
Windows NT 2000 Workstation,
or Windows NT 4.0 Server

Migration Wizard CIEZ < DEENHEML I TWE T2, BT HHi1IC
RO PR EBETT DUNERH Y £77,
BN OBERICEZE LT, BITOFEELTET,

¢ FONT 22—V REDNT 77 ANRLT 4 L7 NVICT7®AL, &
D7 F7ANRLT 4 L7 FUIXEZITH DD,
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ZOEWRIL. BONCBITT S NT O —3, BLXORFHIBITTS
Y= RO ERETIHEEICHALEY, 22—V L7 —T %817
THLEEL, 22— F TV FOBITERIEIC, FO2—PRS
N—TINT TR AMEEES 7 7ANVBLIOT L7 M) 2T X_THE
TC&EE9,

o PO NetWare T— B IR Y 2 —AIINT 7 VX 2 BIT9 D0,

BATHRDONDS YV U —NT, EFOVF—_"BLUORY 2—A03% NT
TANEEZ WO ERTOMENH D £, KBTS LUT,
BNT 7 4 /VFIHk U TR DGFT 2 RINT 520N TEET, 2
PR FHEZNTHITIE, BT NDS 7 U —HN D NetWare H—3
D7 7 ANEEE IR L TR YLERDH Y 77,

¢ FONT2—HFBIWITN—T%2BITT 50 BITHNDS YV U —HND
D NDS a2 FFITBITT 5D,
BITTANT 2—FB LRI L —T%WE L. RICBITH NDS
U—TNT 2—H L 7 —7 2% LTEBNC 2 o T F BT D4
EWRHLHMNE I PERELET, [Project Window] TBATZET /L
b5 L&, NDSOEMHEZE2 Y v 745 &, BIMONDS =27
F BRI ERTE £,

¢ BEfFONDS 2—H 47V x 7 MINT RAA VNTHL2—F 2K
LTWS 0,

TTIEINDS T H U F&EF - TNADNT 2—HF RN NE 0 E 95 Al
ABLET, BITHFIC, NDS VY —CHEE LI-2—V4 2 HmET 50
E 90 EfEE LE T, Migration Wizard CH U —HFZ BRI N5
L. T NIERRENRE T, ZOT =TT, FRENTENT
Z2—HPENDS 22—V F TVl he~=w—TUFTEHNEIDEEETE
3

¢ NetWare F CEITTERWT 7V r—rarRNhr3880. Fok
IS B 2,

Migration Wizard (%, 77V r—ya U EBITLER A, BITRIZT
TNV r—valEFHA ANV THLENHY F9, NetWare b
TERITTERNWT ZV r—va URbH5E1E, FFED NT H—
ERATE TR L CRBE, ZhaT7 7 r—yarh—ne LTf
HTx%d,

¢ 2—PRBIOINAV—TIZHETLHE®RE EOLIITBITT D0, T
FL— ATV =7 SEIX ZENworks™ 22— R Y —oX3y fr—
TOWTIND, BHDVITEOM S EERT 50,

ZEHNZONWTIE, 36 X—T0D [For AL — AT V=7 NEERT
5] BLO37 X—T® [ZENworks = —H R U 3 — Xy r— % 4E
KI5 ZBZRLTLEEN,
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e FEHINTVD FAAL TH DD

BHEINTND FAAL URHL5EIX. BITOE TRIZ, @Yl
NT 22— L T —FZx LT, 2D RAA ORI 2 FEE N Y
THUERHY ET, EEINTND RA AL ORI ZEEE Y Y
T 5121, ConsoleOne™ Z{Fifl L £,

BATOFHRNTE T L7 b, NT OBATE T 210 ¥ 21TV E T,
ROVEEZNEFIZFEITLET,

S AN—=TD [VRATLEML YT T =T B OS]

36 =T D [HEIEEDFAT)

39 X—VD [vA JL—vary P FDFET
RAR—YO BITT 0T =) FDOEF L)

45 =0 BIT7ey=y N ORiE]

46 <= D TBITHONDS ¥ ) =Dt & 7= DBAT
50 X— D [BIT1% DOIEEDFLT)

A Ao B A

VATLEHEVI DI TEHDES

Migration Wizard I£, 7 — % OAT5CCTd 5 Windows NT 4 H—3 F7=
X Windows NT 4 U —2 27— 3 X Windows 2000 V — 27 A7 —1 =7
YOWNWTNINL THIEITTEET, 727 L. Migration Wizard [L7V — 7 A
T—=3ary ERY = ETEITT DT M BATICO D D RF# N EL
KBRVET, ZHUT. 77 ANDaA—RN, VI T NI —7 AF—
VarEMNITIT, BEY— X — RTINS0 T,

KD NT ORI o5 Z & ZfER L T E &N,
¢ NT RAALVBLIOPDC DL YR b UITKT HEXIAL | EHE
¢ BITT 2T RTOTZ A NFBIORT 7 A /WS DRt AT HE
¢ BATHED NetWare — NIkt 2 HEME L FFo2—HF & LTNT R A
An A4 TEHIE

AT D NetWare Y — NI 9D A—"NA FHEERFF-> TV D Z & &
BLTLTEEN,

W DT —7 VL, Migration Wizard DFE[TICEH TV —7 A7 —v 3 >
FF—ANCET NN Ny 2T BB LY 7 MY =T B ERL
TWET,
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TS5y hITr—L4 N—F9z7 YIb+koz7

Windows NT 4 J5 L I® Windows NT 4/2000 7 — 2  Novell Client™ for Windows
Windows NT2000 V—27 A AT — 3 v DifEN— NT/2000( 73— =3 > 4.8
Sty R e 7 B DI )
Microsoft* Service Pack 6
LABE
Windows NT 4 H—/3 Windows NT 4 O f¢{&~—  Novell Client for Windows
(N s NT N—3 3 > 4.8 DI

Microsoft Service Pack 6
LABE

Microsoft Service Pack D/N\— g U B FHRDHI12E, [A¥— K] > [77
ANBERELTCHET] OIEICZ Vv 7 L, TFAR7 40—V RIZ
lwinver| E ASJLT, [OK] %7 U v 7 LEF, Microsoft Service Pack
DA a— RBLOA VA F— U220\ TIE, ZDNet @ Web ¥-A
(http://updates.zdnet.com/products/pr_13616.htm) ZZ M L T 72X\,

Novell Client DBAED/R—T g U ERRDIZIE, V—FT AT —T 30D
N7 A arvzfH7Y w27 L, [NovellClient D7 a X5 4] > [7T57A47T
> M DNEIZZ Y 27 LE9, Novell Client © X 71— RIZOWTIE,
Novell # 7 > 12— K Web A | (http://www.novell.com/download) % £
LTL &N,

WDt 7 vay HEFIEEDEIT) ICEATIE I,
EBEEDELT

ToIL—rAETOH FEERT S

BAHIDORARIERE TR, NT 2—F BT/ NDS v U — 273 % L &
2, FUT L= AT Y=y FERERT L0 E ) hEEELET,

T — ATVl NEERT D E BITRIC, NT 2—WIioxi L
TEMDONDS 2 —V R s ERXTEET, 707 L= FT7 V=7 b
L. Windows NT K XA NZ7RVEBNBEEZ2 ERT DHEIRICER T
T NT 2—HFDNDS YV U —~DOBITE, BITHROEMERS IITZD
otk ni-d, T L= F TV NOFEREHERLET,

BE:R—LTA LY M) EBTTHICE. ToIL—rAT22) FEERT
PRENAHYET.
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TUTVU—= ATV =27 FOTaNT 4 L NT R Y —DRITFERH
HEIBEEALEDYE T L= ATV NOT aNT ¢ MRS
SNFET, LEXE NTHRY —ThD Jeff LWV H 2 —HIZk LT, &
INRAT — FENT LFHRESNT, 77— A7 V=27 FTIR
B SAT — RRP 9 WFIHRES N TV D5 G, Jeff OAT V= 7 |
PBATSID & NDS TIHANAY — REN 9 LFOAFT V=27 FHMERK
éhi‘a‘o

TUT U= F TV 2/ FTERTE HIEIO NDS BYEZ D121,
ConsoleOne #FEITL, 7oV — AT V27 "X TN7 ) w7 LE
T, ZHCED ., BEFEOTa T 4 NI RTERINET,

TRTONT AT V=7 MZOWT, #, K4, BLOHBHIILT8IT
I, ZBIZST5 77— A7 V27 hOTa T o3 BE
TENET,

T — TV MEFEHAT HEA1E. ConsoleOne™ T [7 7 A
N> URER] > (A7 Y=2 M > [T 7Lb—F] DOIEIZZ ) »
JLCT T — b A7 V=2 FEERLET,

ZENworks 1 —H7R) o—N\y5—TF kT 5

ROWEFIEZETIZ. ZENworks™ . —HR Y & — Xy F— V2T %
MEIIPERELET

ZENworks +—% 7R Y o — o r—T 2 FEHTLH L, 2—F DT RJ
kv 7 OHEL L BERE & T & £ 97, Migration Wizard [, 7 /L— 7Tk}
L T/ ZENworks —HR U v—r3y i — D& BT T 97,

ZENworks Z i fl9 2% & . ¥ED NDS 7 /L—FIZBER T 6TV 5
2—HPFDTRTOY =7 AT — a0 LT, TAYZ My 7TONER%E
RETHZENTEET, ZENworks 21— R U > — 3y 7 —% NDS
TN—TICBEMSIT D E, R —Ro =V THEA LT a5 12
XoT, VI RATF—varoEeilEicEEd, Znz1TH I,
FDOIN—=FDa—FITH LT, V=V AT —a O REREL.
gy v — VRPN ~OWHEREZFHIBLC, V=7 AT —Y a0 vy
RE X OB A NS — BT L E T,

3¥ : Migration Wizard 1%, Microsoft NT 3.51 ® Roaming 7O 77/ LZBTLZE
Ao,

ZENworks Zff 3 2356 1X. #1750 NDS 7 U —|Z ZENworks Full 2.0
A A =)L LE73, ZENworks Full Starter Pack %, NetWare 5.0 F 7=
1L 5.1 08 CD 226 A A h—/LT& £9, ZENworks 3.0 i3 74K —k
SNTWERA,

ZENworks —H R Y — R r— P EAERT D121, WEFEITLET,

Windows NTh 5 DTF—42 DT 37



1 NetWare 7 FX=A hL—H T, YU —E=2—{ZHD NDSEHMEL
27V w7 L7, [Create] > [Policy Package] DJEIZZ Vv 7 LET,
NT %y N —21ZHDHU—2 AT —3 a DX A7 (Windows NT/
2000, Windows 95/98, F7=1XZ Dii )5 ) (23T, WINNT-2000
A—YPRY =Ny =V EERT D0, WIN9S-98 ARV r—rs3y
= RAVERRT D, HDVIIFDOM S EZERT D 0ERELET,

2 ConsoleOne T, V—L_X—Da2—WRY o — R hr—IF7 A ar %
7V w7 LET, EOTAarrbnb0Wgait, 74 aro b
WZH—YNVEBET 5 L FWSRRRINET,

ZENworks DA > A h—/LE JOEEFIZEE9 256l SW T, Novell
i~ =27 /LD Web %4 | (http://www.novell.com/documentation/
japanese) ZZ M L TS 2 E WY,

D—ORT—230z88%9 5

U — 7 AT — 3 )b Migration Wizard % FEIT79 2561L. BIT7T 5
RAALNZFDT— T AT —3 3 VIR SN TWAZ L E2RRLTL
a0, ELLSBEINTWDAEARIE, 39 =YD w47 1L—1 g
U= ROFELT) IR F T,

U= AT =39 UINBREEESNTWDS RAL VEEFTHHEIT.
Windows NT ¥ 7213 Windows 2000 (2%} L TR OEEA2FEIT L £,

EE : Migration Wizard (. Windows 95 7—9 X 57— 3 U CIEETTEE A,

Windows NT D—9 X 57— 3>
1 V-V RF—2a T, [(Ry NV —Varvta—X%] 270 v/
L, [Zexsg] 220w 7 LET,
2 Gkpl] #7 %270y L, [£HE] > [FAAL] ORIV v o
LET,

3 WU FAL U ZEEL, BHEOLAMENAT—FE2 A LT
5. [OK] 27V v 27 LET,

4 V—J A7 —3 g%V 77— kL. Migration Wizard % FiC#E) L ¥
T, OB gy (w47 b— a7 0 P— DT ITHEA
TLEEN,

Windows 2000 J—Y X T— 3 >

1 V—JRT—2ar7T, [vA4arvta—%] 270y 7L,

[(TanxFa]l 27V v7 LET,

2 [y NU—ZJID] ¥T7%7 Y v LFET,
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3[7uXF ] BV L, ara—XL LW RALUEAN
HLTm,me, [OK] #27 Uy 7 LET,

4 V— /A7 —3 g%V 77— kL. Migration Wizard % FCH) L ¥
T, WO vay w47 b=y a0 F— ROET] ([ZHEA
TLEE Y,

RATL—2avo1a¥—RFDET

1 Novell Software Downloads Web ¥ K (http://www.novell.com/
download)> [NetWare] > [Novell NetWare Migration Wizard 6] 7>5 4
v m— R34 %M, NetWare 6 Operating System CD & f# f L C.
Migration Wizard 24 > A h—/L LET, FUuro—RFBIOA R
=V OFRRICHENE T,

2 [(AF—F] A=a—nb [Fm 27T A] > [Novell] > [NetWare
Migration Wizard] > [NetWare Migration Wizard] ®OJIEIZZ V> 27 L L
C. Migration Wizard Z &8 L £,

3 [Create a New Project] > [OK] DJEIZZ UV v 27 LET,

4 [Microsoft Windows NT 3.51/4 Server] > [OK] DJEIZZ Y v 7 LE
KR

5 [View Setup Tasks] "¥ > %27V w27 LET,

XKD, TN ED Web 7T U HNEEE L, NetWare
Migration Wizard 6 DA 7 A L~V TR E £7,

6 T TALANTD AT LEREY T b =T BROME ] 12
I TWDO VAT LB IO 7 MU = 7 B2 LT
L2 LEMRLET, 77UV EHLET,

7 [Next] 27V v 7 LET,

8 JKETEIRSINTVDT XA MY 4 —/b FIIRENTZNT FAA
B, BITTDH KA THDLZ L EEBLET,

Migration Wizard Clx, V—27 A7 —2 a VY E3h—BET S
NT RAA CBABICERRSNET,

U — 7 AT —3 3 U H) 5 Migration Wizard % E179 55513, 7 —
JAT—2a UPBEREINTNWD ALV EEETEES, vk
1T 9 1Z1%. Migration Wizard Z#& 7 LT, 38 ~—2 D [U—27 2
T—varaRET L) IZHHISN TV DS FRIEICIENET,

9 BIT7uy=y M4z, RFET 5P 23R LT, [Next]
27Uy 7 LET,
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7 7 4/ h Tld, C:¥Program Files¥Novell¥NetWare Migration Wizard
ZTu Y= MMRIEFEESNET,

10 Fuy 7 XU R MBBITHO NDS VU —%8R L., [Next] &
70 w7 LET,
BATHRDONDS VU —L i, NTT—ZPBITENSNDS YU —T
KR
NDS VU —izua /A4 LTCWRWEAIE, NDS YU —4lZ ke v
Ao A NMIERRSNEEAL, ZO%E, [Browse] R¥ %7
Vo7 LT, MBERNDS YY) —iza /A4 LET, NDS YU —IT
nyArdBHE, FONDS VIV —Z4NBN RKuy 2o )X MNMIEH)
BN FoRENE T,

11 NT R A A U EBITHONDSY V—TCR U4HiZ b 22—V 47 V=
I NERBETDINEIMERTEL, [Yes] £721% [Nol 227V v
]\/iﬁ—o

12 [Create] 7 U w7 L, BiIT7 0y =/ FEERLTHREFELET,

Tulxzl NefERRLTIRGFETSE, Vv bOTha /L
T—u s hkELe 7 7 ANVMERINET, Znbou ik, BT
FEDMLELIRBE DA R SNV E T,

13 CRIUICE > THEIT) TIAE 11 T [Yes] 27V v 7 LEEHEIE, TIA
1BalZHEATLZE Y, [No] 27U v 7 LIEHEEIE. B oFEE
FITREPIZ, 25—V (BT aycr NOEFME] IZEAT

<TZEW,

13a [Browse] " ¥ %7 U w7 L BITIHD NDS 7 U —D NDS =
TFEIEIRLET,

13b VU —ZZRLTNDS = FFA2&IRL, [OK] 27Uy 7 L
i‘é‘o

13c EHE L2 —VHOMBEFIMET 2121F, Next] 227 U v 7 L
i‘é‘o

13d NDS==—H L [6] UL RT 2 FfONT = — T3 5 0 HiE 42 E
Li‘a‘o

WO X, Migration Wizard (CF /RSN D5 2—F 4T —T LD
FITY, ZOMmEMRALET, ZELRWEEIT, RSN
TWANDS =—H, [ UATONT 2 —H & ABIc~— T &
ET,
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& 3 NT 2—H L EHL-NDS A—HDv—

The listed source user will be merged with the displayed MDS uzer.  To change the displayed
N ove I I MDS uszer, click on the NDS uzer name and select a different name from the drop-down list, or
zelect Don't merge to not merge any of the listed MDS users.

Source: OREGOM
Matching User List
Source Lser Name WDS User Mame
Guest Guest Movel -
Adminiztrator Adminiztrator. Novell
Jkap Jkap Movel
Kl b

< Back I Finizh I Cancel | Help |

—EEREINTWVS, FHNT 2—HFIZONWT, kOF S 3
B TEET,

¢ NTa—¥%, FRENEZNDS 2—Hb~—IF5, 57—
JWNZRRENTIENT 22—V E2ZFOFEHELTEBE, RO NT
WL F T,

¢ NT 2—H%% Bl NDS 2—H &L ~—4 5, NDS =—H4
DEIZHDRANVEZ Y v 7358, ZDOITONT =—H% L
FLa—VPLE2E>T_XTHONDS 2—H (2 TF A M
Gte) OFRuyFET YA IRFERENET, VT
DNDS 4 %#BIR L, FREINTVDHKRD NT 22— |7
*9,

o NTa2—H%%, ETHEDONDS 2—H L H~w—T LAu,
NDS =2—%%427 U v 27 L. [Don'tMerge] #7 U7 L
F9, Fry 77X U R MIFERINDTRTDNDS
Z—WR, ZOITDONT 22— L [F— A TRWEGEIT,
COX T a @R L E T,

13e ERINTWVAENT 22— L TA T v a VEBRIRLED,
[(Finish] 7V v 7 LE9,

[Project Window] 2B & £9° . NDS 2 —HF 7=/ F&~v—
VITDHEOIWCBIRLAEENT 2—WE, Fry LA 7oy
kN ERERIC, BITHO NDS ¥ U —ICHEIMICE RSN E T,

DRI ay (BIT7aY 7 FOET L] ITHEATITEE N,
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#1700 FOETIVEE

FE A EDIEZEIT [Project Window] TITW £9, [Project Window] T
. NTO2—VF T V=7 hBIOIN—TF 4T/ h%& NDS =2
THECRT T T R a7 Lz NT 74302 BLORY =2—24
ERBATHONDS VU —MNIZHDEEORY a— L EE 7+ VAT R
T T Ry TEET,

[Project Window] Tl&, EFEOBATZBIGT HHIIC, SESERBITO
PFIVAEETMET D ENTEET, NT A EIBITED
NDS ¥ U —iZl%, ##% 5 2 £8 A, [Project Window] TOBATRIHEIT
TRC, A7 T4 TITWET, 2F V. [Project Window] TIEHH DK
BOERZIT > Ch, BATZ BT 2 £ T, EBRICIIBE £ 72 I3Fk S
nNEEA,

Erbk: FILEES (5) THERHBENT OHE T+ LA ICET HERERTT BICIE.
Windows TR by TOEEDGFHREI Vv L. <FI1>#RLET, RIZ [T
FRAMRER] 270Uy I L, F—T—FOTHFRA T 1s—ILFIC
[$shares] EANLZET,

BTV m Y =2 NEAERT D &, [Project Window] 35X TN [Using the
Project Window] # A 71 7R v 7 ANRFRINET,

WODOIE, [Project Window] @D EH#IZFEK RS 415 [Using the Project
Window] %A 7 17K 7 ZADEITY,

4 [Using the Project Window] &4 7R4 Ry % X
Acme HT Domain Acme HDS Tree

E-T) Actme Dornain @ Acme Tree
Ace Domain Irfo] | El-gB, Acme
NT Server ol Actme Dormsin |

i (C0) Documents [ valume 1
} Projects

1] Drag and Drop lcons

‘wihile in the Project Window, you can drag-and-drop icons [users, groups, and folders] from the
MT domain to & container in the destination MDS tree. To determine what an icon represents,
right-click the icon and select "what's this."

2] Werify Your Selections

Mo data iz actually migrated during the verification process. To verify the selections and resolve
potential conflicts before you actually migrate vour data, select Project | Werify Project or click the
Werify button on the toalbar.

3

Migrate Your Data

To Migrate your data, select Project | Start Migration, or click the Start Migration button on the
taolbar.

V' Always show "Using the Project Window' when a new project is created?
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ERBITTa 2l NI LT, 2OXFATadRy 7 AR REND 3
DDOEAFIEEZFATLES, EITT2 FIEZHELZ5. [Close] %7
U7 LT [Project Window] P&, BiT7av=7 T VLLE
Bth L 9,

[Project Window] #{#H¥ %

WIRTEY MESRLT, BT 7oy 2L, L RNIZ
[Project Window] ZfEf L TS 7Z2&W,

+ #LULNDSEFIEIE T A )L EEMT 5—#1 LV NDSERM (0U) &
TERT B I2iE, NDS B DT Ly & Z 74V E 557 v 7
L. [New Organizational Unit] 721X [New Folder] %7 U v 7 L ¥
9, DKL, [Project Window] TIZ OD#EAEEIT - 726 TI,

5 [Project Window] TEBFIZEHEVI UV I T B
B Project Window: C:\PROGRAM FILES\NOYELLAMIGRATION WIZARDATEST5.MDB M=l E3 I
Microsoft NTA Domain OREGON NDS Tree JONAA-TREE
-2 DREGON -4 JONA4-TREE
----- (@ NT Domain Info (Policy and Everpone Permissions) B- New O izational Ui
[]'"ﬂ DOCLAE_NTS ] ew Organizational Llnit
- KAPSKEEP @@ J  SetContext
= ﬁ MT User Eontalner g E \what's this?
S | . Z JOMAS Backup Dusus
- T | . £ admin
-8 NT Local Group Container [ £ srowe
[]--@ MT Global Group Container |} e & ikap
Es WIMSE User Package

"—'s WIMMT User Package

NDS > U —T#H LW NDSOU #{Ek L, &® OU IZ NT DIEF#®%=%
fTCEET, XD, NT OIE#RSNDS Y U —HND 14 AT E

LoobnET, Tl NTT—XE2BEFO0OUICBITTHZLE T

EFE9, NDS VU —ZiE, HEIZSELTH LV OU 20> THIERL
TEET,

BITHROY U —IZH LW ar T34 BT 28481, #
R U4 H025. kD NDS a4 HEL qﬂéofh\éz%ﬁ%bi%

o ZENT—BETRhRITNIRY A, & 0E. RLarys-WN
C Debra Jones & Daniel Jones @[ /512 DIONES & W\ 9 4 Fij & £+
FTAHZLITITEERAL

¢ TTRARE LS G BIOE VA R () OB T2 H AT
LA, ZNODOXTFORNCH~—7 (¥ 2T 2 46ERH
D9,
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¢ NDS Tli, KXFE/NLFORXR], TorHx—2a7, BIOA
AN RFFRER SN EE A, 72 & 21X, NDS Tl Manager_Profile
& MANAGER PROFILE [Z[R U4 AT E L CH#fibiE 9,

¢ AVTXRAMNERTET S — 2T FAMEHRET DL, NDS 5
ZH27 U w7 L., [SetContext] 7V v 27 LET,

AVTHXFARNERETHEZIZ, NDS YU —0D EDHE % [Project
Window] OHMNCERT 202 ETEET, ZOEEIX, NDS

VY =DV A ANRKEL, ZHDOLT V27 PREENLTHDEEGE
(ZAEF] T,

FREDaTHIZaryTXH A NERETHE, NDS Y U—NTAHT
YVl bETHAICAZa—) L L=, BETILEN R R F
T, AT HFANERE L2 7 F1E, [Project Window] D451
Wik B A TV =7 h & Lfi%rézhi%

+ [Project Window] TH 7L/ FDEBAERTT 5 — [Project
Window] T&7 A 2> OV ZRRT 521X, NDS A7V =
7 a2 Y w27 L, [What'sThis?] #27 U v 27 LE9,

¢« FOYILEA TPz bERICRT — Ry 7 LicA 7 V=2 b
ZICOMEIZRERTITIE, NT A A U EITBATHENDS VU —IC R
2y LIENT A7 V=2 a7V v 2 L, [Back Out Dropped
Object] #7 U v 27 LET,

WOHEEILZ, NDS YU —=ICkny LA 727 e, H7 U v
JIZEHoTERREINDA =2 —DHlZRLTET,

6 [Project Window] TH ISz Y bE2EI U VITD
B Project Window: C:\PROGRAM FILES\NOYELLAMIGRATION WIZARDATEST5.MDB =1 E3
Microsoft NTA Domain OREGON NDS Tree JONAA-TREE
=2 OREGON E-?@f JONA4-TREE
----- ,@ MTDomainlnfo [Policy and Everyone Permissions] B- ,5%5 MOWVELL
[]---ﬂ DOCLAB_MTS yeryonePermissions]

#- 5 KAPSKEEP ___E: Back Out Dropped Db|ec:t

- NT User Container - wihere did it come from?

- Administrator HE  wihat's this?

- &Z FToguct Documentaon
: -8 SMS SMOR Group

al Group Container é’, JOMA4 Backup Queue

[]--@ MT Global Group Container - g admin
- erowe
& tkap

Es WIMSE User Package
"—'s WIMMT User Package
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¢ FAYTLENTATO ) FOTDBRAEFFAND—Ka vy 7 Lzt
T2 RBNT RAAL L DEZIZHST20ERHDITIE, £DONT
ATy ek 2 U w7 L, [Where Did It Come From?] %27 U v
JLET, BEOAT O N RT v I T R Ry LigGEe
Ry 7 LiedA 7Y =2 NBRURNEINT RAAL O EZIZHoTh
ERZTWRTH, ZOMREEHEHTLIERGICHSZ LN T
=FET,

NDS YU —WNT, NT 74 V4%, 2—% BIOI/Lr—7%2F Koy 7L
TR ER 22T, NT T — 2 24T 2RI iT 7 ey =7 b
FRRAE L., BAEIT AR O S D RIE A R L £ 9,

Kot ray BT7aYxr FOKEE] IZEA T EEWN,

BITJ7Ooozo FORRIE

[Project Window] TBATOET MEEET L7chH, HLnA7 =7 k
DG T, BATHED NDS Y U —WNIZHh HBEfF D4 AT, MR, *—
DAR—=AIRE L OFENHEL TORWIERIET 2 LERH Y £
R

KT 77 RRay 7 UEEBIZNDS VY —IZERENETH, =
NHOEABX, NDSY U —NOHBOTY 7T ~a bt —357bD %L
LCEDYBTOHENTWAEITTHDZLICERELTLESN, 7 V=
7 M, BIT7 e A&GT 5 E T, EEICTa—SnEEA,

EBED NT OBATEEIET 5 EMIE T e B ARNFETEINDEIDT, BITD
ANCA Y v KT By OBRFES B e A2 FATTHHERH Y EHA, 7272
L. BITZBBT 2ENCERRT 7 —08E2RE LT & BITH
OREFET vt AL RFENEL 720 £97,

BT 7 —I3, %%’71?7 nY =7 M ERICBRGT DANS, TR
TOMENRHY EY, BEEIBITRICHR TS T,

1 Migration Wizard 0>/ — /L X—"T_ [Project] > [Verify Project] DJIEIZ
7V v 7FBh, V—X—D [Verification] "R¥Z %7V w7 L
THh5, [Next] #27 Vv 7 LET,

2 ROEBI a7 —DIRBATHED NDS WV —~D—H b5 —
ZOBAT] TMBTHFIED TBITHD NDS V) —~Da—H4 &

— X DBAIT) OB LET,
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BITHEDONDS V) —ADI—H ETF—2 D17

NTF—ZDab—ihdR) a—ABIRNa T HIHERLE LA
N, TR FEEBITEINTOWEYA, NT2—VFT7 V=7 b8BT
THENDS AT Ve r MIEHSIL, BT/ NDS > U —ITEE S 1
4, BITABBTHI00E,. WEEITLET,

1 Migration Wizard @ —/LX—"T_ [Project] > [Verify and Migrate
Project] DJEIZZ U v 27 LET,

2 YW OB 2 F5iA, [Next] 27V v 7 LET,

3 FHLLIERLZENDS 2 — Pk LTTF v L — 47 V=7 M2
AT 5851%, YUV —2BKBL, V) —ba—0nb6TFT 07— 4
TV NEBRBINLT, [Next] 27V v 27 LET,

T —=bAET V2T MEFEALZWGARIE, Ty IRy T A
4712 LT [Next] 27V v 7 LET,

FE Rh—LT4 LY MY EBTTDHICIE. NTZ—HFEBITEDNDS Y —IC
BITTHEETUTL— ATOH V2 ERTIVENHYET, AT
BT TL— AT H MIHIELIzh—LT 4 LY YD TANRT A BE
BINTWSIEFHELTLESL,

EVvh: INFETICTFUTIL— ATz H FEERLTOROA, CZTEA
TEHHEICE. TP Y FEFEEL T, ConsoleOne™ #BE, T L—
cr+JSxH FEERLET, KIS, Migration Wizard #BEZE{TL. [Open
Last Project] 2 U v Y LET, RICBITFIEOFIE1 MoBRLET,

4 (R X - THEFT )ZENworks 284 A b — /L I TV AR K
ERITLET,

d4a BATHEONDS VU —%ZMB L, NT 7 V— IR T 5
ZENworks = —H R Y > — v — 58I LT, [Next] &7
Vw7 LET,

4b RNy 7 XU ARG ZENworks T —HR Y —rXy Fr—
@I L T, & ZENworks = —H R Y o — 3w Fr— I B}
FANT VNV —T %@ R LET, HARAEZZ Y v 7 L, Bl
7% 7 n—"7"% [Associate NT Groups] V1 > K7 (2@ L T,
[Next] 227U v 7 LET,

EYh:BIOA A 7OYHRY S ZT, WINNT-2000 & & U WIN 95-98 DR
Jo—Ryr—CFmAE BEIRLEBAE. &#IZ WINNT-2000 7R

=Y T—=VREITEWBT B4 T7ATRYy Y ARKRTEIN, RIZWIN
95-98 iR — Xy r—CREITZMEBFT B354 TRT Ry I ANKRTESh
FF, RUI—Ru5—SDE8 4 TE1DEHBIRLEBSF. F470
TRy RIF1DEFRREENET,

ey 77X 2 MIE, fiOFMETER L2 XTO
ZENworks Z—H R Y o — R r—UREFRrEINET, &RV
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=Ry —UE, BEREDO NT 7V — 7 & AT 5 2
ENRTEET,

4c F5ED ZENworks 2 — R Y or— %o o — IZBHEf 1T D NT 7

N—T %R L, (Next] 227U v 7 LET,

BEATT 2 E 4 5121, [Back] #27 VU v 27 L. FE4b O#E
EZEITLET,

E> bk :ZENworks 3.0 #EH L CTL\5BEX. COE@EIIRTINEEA,

5 Microsoft NT K A A > L BATHENDSY V —CHEHBET D7 7 1 L4 DAL
FRHEEZETELET, ROWTHEZEINL, [Next] 27V v 7 L
jz‘a‘o

*

*

*

[Don’t Copy Over Existing Files]
[Copy the Source File If It Is Newer]
[Always Copy the Source File]

6 NT 2—HD/RAT— ROME FEEZFFELET, kOWT g
WU, [Next] 27U 7 LET,

*

[Assign the Same Password to All Users] — 47 X729 T
Da—FIZH LT U8R T — RRE D Y THRET,

[Assign a Randomly Generated Password to All Users] — 7 >
IR SN NAT — RRED Y THIL, ZHD/RA

7 — R, Migration Wizard & & > TIERRK & 5
project_name_OUT.TXT & WD A HID 7 7 A MM S IVE T,
ZOT77AMIE, BT R Y2y FERILUT 4 Lo N UICHRTE
IhET,

[Read Passwords from a File]— FifED NT /XA T — R T F A
N7 7 A NDBEARIAEIL, BITHO NDS ¥ U —IZB{TS L E
I, BATZBMGT 2RI, NT XA U — REEHTF A N7 7 A
IWEAER T HDHMERH Y 77,

ZDT 7 A NOIERFIEIZBET 25O\ T, [Help] A%
YEIY I LTLIEEN,

7 ROKF T a L ORICHLIF v IRy I AT F-134 712
LTCNTOBITA S v a v &REL, [Next] 71U v 7 LET,

*

[Migrate File Permissions] — %, 7 7 A VB LT 4 L7 K
V2B A HEFIIL, Migration Wizard (2 X > CTRBATS L E T, i
SMOEHT, 77 ANVEBIOT 4 L7 FUICEET DHER %

FOLTTHHEEIE, 77 ANVBIOT o L7 MVICET M

FEzabe—LRnE 922 ZTHEL, % T ConsoleOne % fii
LTHBEIDY T EnTEET,
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+ [Migrate Everyone Permissions] —NT R A A V@A T T =
F& Rve w7 L7z NDS 227 121, Everyone 7 /b— 7 |2 B
fFiF 6&'@/‘71*@*”75)% |0 2% CHET, Everyone 7 /L—7 D
MR Z AT T 28815, NT KA A UAFHA 72 =7 b % NDS
DR N AN bm/7b FTRTONT 2 —FNZ OHEF &
MATEDEIICLET,

EVRINT RASVTHERINDZTRTOF LWL I+ ILAIZIE. BEIMIC
T 74 )L kT Everyone MIEFMNEIY BTHhFET,

¢ [Restart Option] — %, BITICET 2IHHITIHE S ILEE A,
T2 LURNCBATE T L, BITHDOY YV —MhBENDS A7V
7 FEHIRLIZEA, FU RAAL OBITERNNHR0 BT
Wi, 20T 2w IRy 7 AEF A LET,

NT N 2—HFRBINITN—T%2BITT 5 L. NT AL O
fHiF 572 NDS 22—V DT —T AN, 774 ~U RAA >z
YhE—Z PDC) DL YA RVIZKMINET, 77 AL R
T LEBAITT H & 12, Migration Wizard (22 D7 — 7 /LD 1E#R
PHEHALET, 2OTF—7NICIE, HFa—FB LRI L—T3,
BATHEDO NDS >V U —D & ZIZBAT SN D iidk STV E

T, BITEOEREEMT LIk, ELW T 7 A LDT
7 AMEDEY) 2 —FICED S TonET,

8 (RINICE-TEIT) AX L FT u v DRiE7n v 22 FIT LTV D
e, BT — b2 AB LR 2 — 24 XEFHD
MEIDERELET, INOLOFEREFDLEEIT [Yes] 24
ZL., [Next] #27 VU7 LET,

Z OMEZIIRER DR 0 DT, BT Y =7 N EREET

BN, HRIB L ORY a—2H A AEFEARDILEBEHY FH A,

72 L, NT 77 ANV AT DEEINT D200+ 5728 S REN,

BATHDORY 22— WZHHNE I DERIET 2561203, 2 0N
RN B E T,

Migration Wizard [Z, FR v 7ENT7 VX ONEEZAFX ¥ L,
INLDTANFEBATT 272D D570 R B 2028 9 ik i
FAELET,

FEINT T A=A FHEETAILETEENTEES, TALIMUE
BOL—MIHLTIRTOEREF>TWLTE, T4 LY FUBESKICH
LTRLCERZFERATESLERY FEA.

9 [Verify NT to NetWare Project] ™7« > R T, [Next] #7 U v 7 L
THEEZBRLE L £,
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10 7o 7 IRFERENTZEGEIT, XA THRERRDLAT V=7 MET
DARTOFE Z R L, [Next] 227 U7 LET,

BATINBRIRDF TV = bae~v—U T D0 TOEEITTLH0%
BIRTEET,

11 7 7 IREREINEZLEIE, YA 7HRRICAT V=7 FETO
LETDBA R L, [Next] %27 U v 27 LET,

A TMRECAT V2 bae~v—UF 50, TOEEITT LH0EE
RTEFET,

12 7o 7 MRFEREINTEZHEIT, FRENZNT 2—HF B L0 L —
TEBITLIRWZ L 2R L, [Next] 27V v 7 LET,

ZOFNEE, TRTONT B—H V7 —F kLT 1Al NT 7
B— LT =Tk LT LA, BATHENDS YU = KT v 77 v
FRey 7 L TWARWNT 2—Fi2xf LT 1o, &3 m%EfTd
HUBEBRHVET, 9 XTO2—FBIONITNV—TZ2BITLIESE
X, ZoXATa TRy 7 RAIFRINERA,

MR HoTHEAENE, [Cancell 27 Vv 7 LET, ZHUTLD,
[Project Window] (ZREV 9, A7 V=27 ha2 RT v I7 T KK

7y 7L, Y—/3—"T, [Project] > [Start Migration] DIJHIZ
Uo7 L., ZOFEEZ 46 X—OFNE 1 >HFBH L £,

13 BRI —NHIUTT I TR L ET,

AEFIIIEKRTIE RV T —1, BITRICRETEE9, EAR
T —F 3B EEMIT AR, Z 9D TILHDHTF AR
74—V FiIZFR SN ERAE T, ZOFBEICE. Bxbh
BENE . REDT-DDOE v PRI TWET,

14 ROWNTINEFEITLET,

¢ ZOWFET, EBEOBITEIT> TWAEAIE, [Proceed] % 7
Vw7 L, BITERITLE T,

o ZTOHET, AXVRTuL ORI AT EETLTY
DA%, [Finish] 227V v 7 L, 46 X—2 D 3114 NDS
VD LT =X DT TORRRIIIE > TEBEOR
1THBAB L £,

15 (BITOBADOHR) =T —n 7B LR I RnFERSnEzT,

wDOET7 vay TBITHROIEREDET) IZEA TSN,
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BITRDEEDETT
NT 75— #BITHDONDS VU —IZBITLI-%. REFEITLET,
Q UV—7 25— 3 ZHEHFTDONovellClient / 7 h T = 7B A A h—

ILENTWVWRWEARIL, 26D T —7 A7 —3 3 |2 Novell
Client Y 7 b =7 %A VA =L LET,

wH DY 7 AT MiE. Novell Software Download Web ¥ T (http://
www.novell.com/download) 72> H % 7> u— R CX£9, HEOT—
27 AT —3 3 |2 Novell Client Z [[RFIZA > A h—/L4 5 HFHEICD
W, (http://www.novell.com/documentation/japanese) C Novell Client
D~v=a2T VEZHRLTITEEN,

O ConsoleOne Z{#HH L T . BFTIHEDONDS YV U —DIE LWEFFICNT == —
FEIONTL—TR"BITIN, IELWT 7 AL &5 OMER] 2 (75
LTCWBZ EEfERLET,

Ey bk RELTOLWAERNATELTWDEEELIEETESE4(E. DOS 7

N> 7T lcacsy?] EAAL. BEODIERICHELET, Microsoft 1—F 1
T4 Tk, EADARTINBVEENHBYET, COaT2 K€ DOS Ay
FRTEFTEENTA TS Y FMoEERTF LA TLBIERA, REEhA
WEDHLEHTIRTRERSINET,

Q B175E 0 NetWare $-— /3T ConsoleOne Z i [ L T, 7 — &% OBITHER
Va—2b%&FRRL, ELLSBITNMTONIEZZ E 2R LET,

Q NDPS® TPV v 2~y B ERELET, BREHEICHONT
. BT —A"TEEL TV AR L —TFT 4 VTV AT ADF
Z A~ == 7V (http://www.novell.com/documentation/japanese) %
% . [Print Services] > [Novell Distributed Print Services] DNEIZ 7
Uy 7 LET,

Q BITLIz2—VDOR—LT 4 L7 MU ZFH, FHEEE D BTSN
TWDHZEZEMERLTITEIN,

QO X THO2—WFITHLWNDS N2 T — R&RALET, AT —F
I%. Migration Wizard (Z & > TER S 4172, project_name OUT.TXT
EVWINRAT = RT7 7 A VSN TWET, ZDT 7 A VL,
BIT7uv e NeRGFLET L7 RUICZHD £7,
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cS IO a—TFTa Y

FAELEMBEORNRIIEC T, @it rva v aZRLTIIEEN,
o —fRANZeBEE ORI (51 ~—)

¢ U= AT =3 b — SO (52 <X—)

o A B SO (53 -

¢ T AP — (53—

¢ SMDR =7 — (54 ~<—3)

¢ NI AT 4 DT (54 R—)

¢ NUWAGENTNLM (55 ~—3)

¢ NICI =7 — (55 X—)

* NDS DAT (56 <—3)

— & B4 75 BE R OD R R

PRl B 5 RE R Z [T 572012, RO Z L Z2mEgd LT IZS
Wy,

o BT LUOBATHOY— Iz, BITICHNERY—N"ET—T X
T—va AL CHIETRERTA B ANDDHZ &,

o BATICE T % NDS® o —|2, R ORIRA RN &, Zh
EFRRDITIE, WEFITLET,

¢ U—27 A7 —3 3 T ConsoleOne™ % E{TLF T,
¢ NDS =% 4T V=7 hOT a7 4 ZiRELET,
¢ [Login Restrictions] # 7% 7 UV v 7 LE,



¢ [Limit Concurrent Connections] F = v 7Ry 7 A&+ 712 LF
R

o BAITICHEMT 5 NDS =2 — I BATIE Y — YO NDS A7 V=7 hiZ
KT D A=A FHERHDZ L, NDS —HFDNDS 47 V=7
ENBBAT I — "D [N —F] VA NMIGENTND I L&k
95121, ConsoleOne™ Z 1 L £,

J—H9 RAF—2 3 U S Y—IN~DELE

Y= NE U =7 27— g OB OMENL £ T I THEFRFCIEN H 555

BliE. WITRT VT TN a—T 0 VT OBEEE 1 DU EFEITLET,

¢« JGA T NIT—I RAF— 3% YT — kLT, Novell® Client™
DXy am7 U7 LET,

s n AT BHERDOVIZ, RIA T2V —NZ~vy X LET, 20K
EIE, IPX™ 7o k3Tt L T D55 I RFICER T,

o ZETORDVIZIPT RLAEFIZIPXT FLATYH—R"ZHRELE
9, [Novell Login] # 4 7 v 7R 27 AP [Server] 7 4 —/b KiZ
IP7 FLAEIZIPX T RLAZAZ AN LET,

o =TT EANL, VIV —HEIUTFANEZEHIZLT,
NDS ¥ U —TlI7e < r— N L £ 97,

o REHREBR SN EZ T XTUM LET, ZNETHITE. NTA
a7 Y w7 L, [NetWare Connections] #7 Vv 7 LE4, &
FEEZIT TR NT RTOPF—REBLOY U —0 586 & bk L.
HEo /A LET,

o WOFNET, [Preferred NetWork Protocol] NIE L BEIN TS
TLEMERLTLLIETE N,

¢ [Nl 74 =zt vr7 LET,

+ [Novell Client Properties| > [Protocol Preferences] DIJEIZZ U v
7 LET,

o VERMERE Ry NU— T haLZ@ER L, [OK] 27V v
7 Li‘é—o

¢ U—JRAFT—vark )7 — LFET,

’ﬁ%LTW%NCNHFJW% BATHA — "B v R L E
T, =& z0E. BAT imx%@%#é# BATH Y — NI IP 28
NAVRENTND . BATRRICRBAT Y — "D IP 7'u fha iz
INA l\ﬁ%ﬁ?biﬁ‘
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H— I\ B Y — /N~ D EH

P S OGO 7 F T | THEF ISP b B AT, WITRT T 7

Ny a—T 4 T DR 1 DL EFATLET,

¢ NDS ¥ U= bBATIE £ 73BT R OY — SR HIR S AL TR
FERR L E T, BATHHCIE, H— 308 Y —NOMOH—/3 L il{E T
DL L TR LERHY £,

o BTGB LOBITEOT — ABHEIGERETE 5 2 & 2 MR LTS
7ZEW,

IPX #E/HO%HEIL. Y— "2V —/,L'C [DISPLAY SERVERS| &
ATTLFET, IPEHROHEIL, —Xa Y —LT [PING] & A
JILET,

¢ IPX ZfEH L TWAHEIE, BTt —BIXUOBITE— D7
V=X AT EIPX Xy NU—2FE /P —NID BHE—INTWND
ZEERMEERLTLIES N, IPE#ROL X, XS 57 RL A
E, TRy h~RA7 BXOF = U oA OFEFRPHES LT
HZ ERMERLTITESN,

» BATRY—"2 U7 —FLET,

74 I)LODaE—

T ANDa—RRHIBEN A LESEEITE, RIS T T

Va—T 4 VT OBEEEITLET,

o BITHREBITICOWM DY =T, a4 2HMILET, 77
ANDav—%BET BRI T A R o TnBE, Ty
ANEBITTDHEIC, Y—\BMHEICe A T H5ENTEE
A,

E o oOTA4 UNEMCHESESITEIRL THBIHEE. Migration Wizard TlE,
THOOT A U EEMLET,

o T ANDA—IZRFEIBRPNDEEIE, VN U—T X T —
varOEDO LAN HENRKICRE SN TV R0 ERER L T
<IZEW, NICBELOY =T —7 27— g U EO@EHE .
TROECHFAFIETETHETE I —Fa—FahT
WAHZEEMERLET, 2O DOBEOFREIT. TXTHRLICT S
VENRHY 4, ETEHETHENIRET L L THIUL, T EHE
ERLET,

o EfET7 7 A NEIEEMHRY 2 — BT THHE. 77 A0
E—DEENEL 2D DB 7,



SMDR T5—

BATH Y —/ S THEITL TS SMDRNLM 7' 2 77 A8 BATILH—
IR CE WG ERHY £, ZORMBEEMRT 51213, ROBIEE
1 DLLEFEATLES,

*

*

BATIRS — % ) 7— F LET,

EHLCWenWT e hanz, BT — "\ 1 o RiFfR L &

9T, T2 ZE, BT IPX 29 228, BTk — N2k P i
NA Y RENTWABEES, BITRHIBITHEY — D IP 7u ks
INA v RERR L £,

Migration Wizard 23 i@ 9] 7e TSANLM & AT e — N\ Ic e — R TX 7
AT, BT — "oy Yy — AL FEica— RN, @O
TRICHEWET, £21EY— 2V —/ T SMDR NEW] & ASIL
T. SMDR A7V =7 F&EAERR L £,

BT — Y — 3 Y —)LTSMDRNLM % 2 — R L., B17%%
DY —/"z YV —/LT [SMDR NEW] & AJJL T SMS™ O [RE % fi#
FLET,

KHIDONLMM 7' 7 F A3 — REINTWDZ LR LT ES
A%

Migration Wizard |, %72 NLM % B1T08 K OBATE O+ — |
HEIMICaE—LET, RFONLM Ar— RENTND Z & 2
P89 A 121X, NetWare Migration Wizard¥Products¥NW3x 7 4 L7 K U
DT 7 ANERNET, BHEICL - TIE, TSA312 ZF#)T
0— RTLH0ENHY £,

TIA2 VR ERRET, VATALANLAD [N] TA 2%k
7 U7 L., [NetWare #fc] #27V v/ LET, BITEOYV U —F
FOH— 3, [T 4=V ] LT 3NTNHI LERERL
TLTIEEY,

NetWare 3 2 LBATT D56 1%, BITE—NIC /X arTx
ARMNMEESNTWNWDZ LEEMERLTLZEV, NetWare 6 (2177
BT, BT DY —2 Y —)L T, [set bindery
context = o=[context]] * AJTILE7,

S XT 4 DET

*

kT 2T 4 OEITCITRI L, Oxfffffffb — 5 — 234 LI 8ald, &
FERTRTOYEFTTIP Y RLADEENMTOILTWRNZ &R L
TWET, FHICOWTIE, 28— [BREHRIET 7 A )LD

] ZBBLTIEE N,
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¢ NT AT 4 OB VE 2 5E X, Migration Wizard T, [Finish NDS
Migration] R& %27V > 7450, V—/s3—0 [Restore
Trustees] Z RN L £,

NUWAGENT.NLM

NICI T35 —

NUWAGENT.NLM |, Migration Wizard D% < OALEECfEH S 5H NLM
7177 ATT, NUWAGENTNLM % 10— R CX RN EWV ) T T —23%
ALTESEAIE, ROBEEZFEITLET,

o — RV —nt, FE)TNUWAGENTNLM 22— R LE9,
o BT —Ra Y —)L T [SMDR NEW] * AJJLET, ZHiZ

X v, SMDR #FHENFHIER S, NUWAGENTNLM 21— K T& 5
Lo F9,

Migration Wizard C, NDS O 12— RHIE 72|I NICI 7 7 A /LD =2 B —H1|Z
NICI = 7 —23 54 L7288 1%, NICI 7 7 A VB EN TV 5 ATREMED &
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PR L £,
NICI =Z —F 7238 ET 25 A81%. Novell iR — hlR—L~_—

(http://www.support.novell.com/search/kb_index.jsp) T, TID 10025666
AR LTSN,



NDS D #1T
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RREIZ 22 £,
1 BAT Y — DY —nRa sy — T ROWThhDa~y Rae A
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INSTALL] * AHLET,
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2 [Directory Options] > [Directory Backup and Restore] > [Restore Local
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225 NDS ZHIBR3 2 48N H Y £7,
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ShET,
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ZEHEAETOMAL E LT [Root]] E AT LET,

SUITNY T L REA LY — AT AIEERRER SN SS
1%, AW L C <Enter> ZH L £,

=NV TV IO AF a—%RFF L TWAGEIR, BElE
TRENFET, <Enter> L F7,



1M ~RF VT B EBRET72012, oy —_EZHEELET,
NWCONFIG Z#H L TR — "% T o X AEIRT DB Z L,
=P RFEDT —NERET DI L TEET,

12 NWCONFIG = —7 1 U7 1 IZJE Y . [Remove Directory Services from
This Server] DERIZ L - T, NDS MHIBRI N7z E ) nE iR L
£

NDS NI TIZHIFREN T WD E NI A vt —UNRFREINT-HE
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NDS BIE L HIFR S 72 723E &, NWCONFIG 2 T L. B
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